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CHAPTER 1

Creating a Project
Let's start by creating a new project based on the Product Foldout template.

CREATE A NEW PROJECT
1. Select File > New Project. The Start New Project Wizard opens.
2. In the Project name field, name your project My Foldout.
3. (Optional) In the Project folder field, you can enter a location where you want to save your project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.
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5. Under Factory Templates, expand the Print folder. Select the Product Foldout template.

6. Click Next.
7. Click Finish. The project is created and loaded into Flare.
For more information about using this wizard, see the online Help.
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CHAPTER 2

Creating Page Layouts
Page layouts are used to configure the pages for print-based output and are especially important in
this particular template because of its unique characteristics (e.g., multiple pages, background
images). This template comprises only two topics—one for the front of the product foldout and the
other for the back of the foldout. Therefore two page layouts are required—one to be associated
with each topic.
When you go through the following steps, you will see that two page layouts already exist in the project, and they're already completely edited. If you want, you can open these files and take a look
around to see what you will be producing in the end. You can also build one of the targets in the project to see how these page layouts are incorporated into the output.
In the following sets of steps, we will create two new page layouts, replicating the look and substance of the existing page layouts.
This chapter discusses the following:
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Back Page Layout

25

7

Front Page Layout
The existing front page layout in the project is simply named "Front." We'll give our new page layout
a slightly different name.

CREATE A PAGE LAYOUT FILE
1. In the Content Explorer, expand the Resources folder, then expand the PageLayouts folder.
Notice the existing two page layouts (Back and Front).
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2. Right-click the PageLayouts folder, and from the context menu select New > Page Layout.

The Add File dialog opens.
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3. Under the Factory Templates, select the Default template, because it is quite simple and
requires fewer changes than other templates.

4. In the File Name field at the bottom of the dialog, type Front2 as the name for the new page
layout.
5. Click Add. The page layout is added to the Content Explorer, and the Page Layout Editor opens
to the right, displaying the page layout.
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6. Before we continue with the rest of the steps for editing the page layout, let's make a couple
of quick changes in it.
7. Click the header frame (the rectangle) at the top of the page layout.

8. Press Delete on your keyboard.
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9. Scroll down to the bottom of the page layout. You will notice the footer frame, which is automatically selected.

10. Press Delete to remove it.
11. Click

to save your work.

For more information about adding page layout files, see the online Help.
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SET PAGE SIZE AND MARGINS
Now that we have created our first page layout, we will start making changes to it. To begin, we will
adjust the page size and margins.

1. In the local toolbar of the Page Layout Editor, click
down arrow).

(click the face of the button, not the

The Page Properties dialog opens.
2. Select the General tab.
3. Click the Page Size drop-down and select (custom).
4. In the Custom Width field, enter 20, and for the unit of measurement select Inch (in).
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5. In the Custom Height field, enter 5, and for the unit of measurement select Inch (in).
6. Keep the Orientation field set to Portrait.
7. In all of the Margins fields, enter 0.

NOTE: You can set some value for the margins on your page if you want. However, in
our template we chose to set them all to 0 and specify the margins on our CSS styles
instead.
8. Click OK.
9. Click
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to save your work.
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10. Because the view of the page layout is so large, it is difficult to see what's going on so far.
Therefore, in the local toolbar, click View and select Fit Width.

The page layout is zoomed out so you can see all of it.

For more information about specifying the page size and margins, see the online Help.
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CREATE PANELS USING MULTIPLE BODY FRAMES
Now that we've resized the page layout, we're going to divide it into three panels, which will serve as
the natural locations where the printed output can be folded. One way to do this is to create three
columns in the existing body frame. But one of our panels is going to be wider than the others, so
we’re going to do it another way, by adding three more body frames to give us three total.
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1. In the Page Layout Editor, click on the left side of the page layout. You will see orange circles
that represent the four corners of the current the body frame, which is not the size we want.

2. Double-click the body frame. The Frame Properties dialog opens.
NOTE: An alternative is to simply click and drag the body frame, and its edges, until
you have it placed just where you want it on the page. However, in this exercise, we'll
use the Frame Properties dialog, because it's easier to get the precise size and position that you see in the template.
3. Select the Frame tab.
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4. We want to set the body frame so that it is the exact height of the page, is half its width, and is
positioned all the way to the left. So set the fields as follows:

Notice the high number (530 px) for the right padding. That is because we don’t want text to
overlap the background image that we’re going to add to this body frame.
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5. Select the Columns tab and in the Gap field, enter 0.

6. Click OK. The page layout should now look like this, with the resized body frame selected:
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7. On your keyboard, press CTRL+C and then CTRL+V. A copy of the body frame is created,
slightly overlapping the original one.
8. Double-click on the new body frame. The Frame Properties dialog opens.
9. Select the Frame tab.
10. Set the fields as follows:

11. Click OK. The second body frame, smaller than the first, should now be placed directly to the
right of the first body frame.
12. Make a copy of the second body frame and double-click the new body frame that results. The
Frame Properties dialog opens.
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13. Set the fields as follows:
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14. Click OK. The third body frame should now be placed directly to the right of the second body
frame. The page layout will look as follows. Notice the arrows showing the expected flow of
the content from one body frame to the next:

15. Click

to save your work.

For more information about editing the frame size, see the online Help.
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SET BACKGROUND IMAGE
The front page layout is almost finished, but we want to add a background image to the first body
frame, and position it on the right side. We’ve already set the margins in that frame so that the text
is shown to the left of it, with no text displaying on top of the image. But if we wanted, we could have
text or other content display above the background image, which could then function more as a
watermark.

NOTE: You can also add a background image to an entire page layout, and not just a body
frame.

1. Double-click the first body frame. The Frame Properties dialog opens.
2. Select the Background tab.
3. In the Image section, click Browse.
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4. Under the Resources > Images folder, select Background-Panel2.png. Click OK when you are
done.

5. In the Repeat field, select No repeat. Also, set the X field to Right.

6. Click OK.
7. Click

to save your work.

For more information about backgrounds in page layouts, see the online Help.
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Back Page Layout
In the Content Explorer, make a copy of the Front2 page layout and name it Back2 .

In the end, the Back2 page layout will be much like the Front2 page layout, with a few exceptions.
For example, it will have four body frames instead of three. Also, it will use a different background
image. Therefore, complete the following sets of steps in the Back2 page layout to make these
changes.
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CHANGE BODY FRAMES AND BACKGROUND IMAGE
1. In the Content Explorer, double-click the new Back2.flpgl file.
2. To see it better, you can click the View drop-down in the local toolbar of the Page Layout
Editor and select Fit Width.
3. Double-click the first body frame. The Frame Properties dialog opens.
4. Select the Frame tab.
5. Set the fields as follows:
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6. Select the Background tab.
7. In the Image section, click Browse.
8. Under the Resources > Images folder, select Background-Panel5.png. Click OK when you are
done.
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9. Set the X field to (default).

10. Click OK.
11. Double-click the second body frame, which is currently positioned where the third panel will
be. The Frame Properties dialog opens.
12. Select the Frame tab.
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13. Set the fields as follows:

14. Click OK. The body frame is now positioned next to the first body frame.
15. Double-click the third body frame, which is currently positioned where the fourth panel will be.
The Frame Properties dialog opens.
16. Select the Frame tab.
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17. Set the fields as follows:

18. Click OK. The body frame is now positioned next to the second body frame.
19. With the third body frame selected, press CTRL+C and then CTRL+V on your keyboard. A copy
of the body frame is created, slightly overlapping the original one.
20. Double-click the new body frame.
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21. On the Frame tab, set the fields as follows:

22. Click OK. The body frame is now positioned next to the third body frame.
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to save your work. The back page layout should now be complete, and it should look
23. Click
like this:

For more information about editing the frame size and background, see the online Help.
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CHAPTER 3

Creating Topics
Now that you've created a front and back page layout, you can create a front and back topic to go
with each.

CREATE NEW TOPICS
1. In the Content Explorer, right-click the root Content folder, and from the context menu select
New > Topic.

The Add File dialog opens.
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2. Under the Factory Templates, select the NewTopic.htm template.

3. In the File Name field, type Front2 as the name for the first new topic.
4. Click Add. The topic is added to the Content Explorer, and the XML Editor opens to the right,
displaying the topic.
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5. Follow the same steps above to create another topic, except name the second topic Back2.
Now you have two new topics to go with the existing "Front" and "Back" topics.

Currently, both new topics look rather plain when you open them. But that will soon change
after you associate the topics with the two page layouts that you've already created. Also,
additional content and some styles will help bring the topics together.
For more information about topics, see the online Help.
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CHAPTER 4

Adding Content to Topics
Adding your own content to the topics is relatively simple. But because the output is print-based,
and a bit unique, there are a few things to keep in mind as you work in the XML Editor.
This chapter discusses the following:

CHAPTER 4

Layout Modes and Style Mediums

37

Adding Content in the Front2 Topic

41

Adding Content in the Back2 Topic
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Layout Modes and Style Mediums
The way it is displayed in the XML Editor depends on the layout mode that is selected, as well as the
medium. This is especially important with this template, because you really need to see the appropriate page layout as you add content. If you are looking at a topic in Web Layout mode, you won't
see this and it will be more difficult to work.

SELECT THE CORRECT LAYOUT MODE
1. Open the Content Explorer and double-click Front2.htm.
Chances are pretty good that your topic will initially be displayed in Web Layout mode with the
default medium, like this:
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2. Click the Layout (Web) drop-down and select Print Layout.

The look of the topic changes to this:

This is the Back page layout (not the one you created, but the original page layout that came
with the template). It is being shown because it is the first page layout listed alphabetically in
the Content Explorer.
But what you really need is the Front2 page layout that you created.
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3. In the local toolbar click the Page Layout drop-down and select Front2.flpgl, and in the flyout
menu select Normal (the name of the only page in that layout).

The display changes, showing the correct page layout:
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Also, notice that the medium selected is print.

This happened automatically when you switched from Web Layout mode to Print Layout
mode. Flare anticipated that you might create both online and print-based output from your
project, and the default medium is typically used for online output while the print medium is
used for print-based output.
4. In the Content Explorer, double-click Back2.htm.
5. If the topic displays in the wrong mode, click the Layout (Web) drop-down and select Print Layout.
The topic displays with the original Back.flpgl page layout. It looks correct, but lets sync it with
the new page layout you created.
6. In the local toolbar click the Page Layout drop-down and select Back2.flpgl, and in the flyout
menu select Normal (the name of the only page in that layout).
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Adding Content in the Front2 Topic
Now we need to add content to the topics. This includes text, images and variables. We will start
with the Front2 topic.
In this template, we've created some variables. On the first panel of the foldout, we used them for
the year of publication and company name. Then on the last panel we used a variable for the
product foldout title. Variables can be beneficial if you plan to use the same page layout for multiple
outputs. For one target you can use the default definitions for the variables, and you can override
the variable definitions for any of the other targets you might generate. For more about variables
and overriding definitions in targets, see the online Help.

ADD CONTENT FOR THE FIRST PANEL IN THE FRONT2 TOPIC
1. In the XML Editor, click the Front2.htm topic tab to bring it to the front.
2. In the Front2 topic, replace the heading with the text H1 General Information. Then
replace the paragraph below it with different text (not too long, but a few lines is okay).
3. After the new paragraph text, press Enter to create a new empty paragraph.
4. In the Content Explorer, expand the Resources folder, then expand Images under it.
5. Click the Squares.png file, then drag and drop it to the new empty paragraph in the XML
Editor.

6. Click after the new image, and press Enter to create a new empty paragraph.
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7. In the local toolbar, click the Character button

.

8. Find and select the copyright © character. Click Insert, then Close when finished.
9. Type a space after the copyright character that was inserted. Then in the local toolbar click
. The Variables dialog opens.
10. With the General variable set selected on the left side, choose the Year variable.

11. Click OK. The variable is inserted into the topic.
12. Type a space after the variable that was inserted. Then in the local toolbar click
The Variables dialog opens.
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13. With the General variable set selected on the left side, choose the CompanyName variable.

14. Click OK. The variable is inserted into the topic.
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15. After that variable, press Enter again. You can then enter another line of text if you want to
match what was done in the original Front topic. When finished, the first panel of your Front2
topic should look something like this:

16. Click
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ADD CONTENT FOR THE THIRD PANEL IN THE FRONT2 TOPIC
The text that you just added will display in the first panel of the output. The background image will
display by itself as the second panel. Now we want to start adding content for the third panel.
1. After the last line of text in the first panel, press Enter. Then type H2 Lorem Ipsum, which
will be a second-level heading.
2. Press Enter again and enter some paragraph text so that it takes up a couple of lines.
Notice that the new text moves past the image and into the third panel automatically. That’s
because the first text that you added, as well as the image, are using the first body frame,
which is twice the width of the other two body frames. The right margin in the first body frame
is so wide that it doesn’t allow any text to display over the background image. So when you
add more text than can fit in the first body frame, it starts using the second body frame, which
as far as the end user is concerned, appears as the third panel.
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3. Select the new heading and paragraph text, then copy and paste it a couple of times. When
you are finished, it might look something like this:

4. Click
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to save your work.
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ADD CONTENT FOR THE FOURTH PANEL IN THE FRONT2 TOPIC
In the fourth panel of the front topic, we want to add a company logo, followed by a variable that displays the foldout title. However, since we have not yet applied styles, the new content will not yet be
placed where they should.
1. After the last line of text in the third panel, press Enter.
2. In the Content Explorer, expand the Resources folder, then expand Images under it.
3. Click the Logo.eps file, then drag and drop it to the new empty paragraph in the XML Editor.

4. Click after the new image, and press Enter to create a new empty paragraph.
5. In the local toolbar click
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6. With the General variable set selected on the left side, choose the Title variable.

7. Click OK. The variable is inserted into the topic.

8. Click
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to save your work.
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Adding Content in the Back2 Topic
Now let’s move on to the Back2 topic, where we have a similar situation in that one of the panels has
a background image. However, in this case, we want to add some content to that panel so that it displays on top of the background image.

ADD CONTENT FOR THE FIRST PANEL IN THE BACK2 TOPIC
1. In the XML Editor, click the Back2.htm topic tab to bring it to the front. The first panel contains the background image and default text.
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2. The h1 text currently has the same color as the background image, so you cannot even see
the text. However, if you select it, you will temporarily see the text while it is highlighted.

3. Replace the heading and the paragraph under it with the following paragraphs:
n

First paragraph Get Started in

n

Second paragraph Just a Few Steps

n

Third paragraph For more help or troubleshooting, please visit our online documentation:

n

Fourth paragraph www.yourcompany.com/help

n

Fifth paragraph Created Using MadCap Flare
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When you are finished, it should look something like this (if you once again highlight the heading):

4. Click
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to save your work.
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ADD CONTENT FOR THE SECOND PANEL IN THE BACK2 TOPIC
1. After the last line of text in the first panel, press Enter.
2. In the Content Explorer, expand the Resources folder, then expand Images under it.
3. Click the Step1.png file, then drag and drop it to the new empty paragraph in the XML Editor.
Due to its size, the image displays at the top of the second panel.

4. Click after the new image, and press Enter to create a new empty paragraph.
5. Type Step 1 and press Enter.
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6. Type a short two-line paragraph. When you are finished, the foldout might look something like
this:

7. Click
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to save your work.

53

ADD CONTENT FOR THE THIRD PANEL IN THE BACK2 TOPIC
1. After the last line of text in the second panel, press Enter.
2. In the Content Explorer, expand the Resources folder, then expand Images under it.
3. Click the Step2.png file, then drag and drop it to the new empty paragraph in the XML Editor.
The image displays at the top of the third panel.

4. Click after the new image, and press Enter to create a new empty paragraph.
5. Type Step 2 and press Enter.
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6. Type a short two-line paragraph. When you are finished, the foldout might look something like
this:

7. Click

CHAPTER 4

to save your work.
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ADD CONTENT FOR THE FOURTH PANEL IN THE BACK2 TOPIC
1. After the end of the paragraph that you typed, press Enter.
2. In the Content Explorer, expand the Resources folder, then expand Images under it.
3. Click the Step3.png file, then drag and drop it to the new empty paragraph in the XML Editor.

4. Click after the new image, and press Enter to create a new empty paragraph.
5. Type Step 3 and press Enter.
6. Type a short two-line paragraph. When you are finished, the foldout might look something like
this:

7. Click

to save your work.

MORE INFORMATION
For more information about the different kinds of content you can add, see the online Help.
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CHAPTER 5

Creating Styles
The page layouts, topics, and TOC have been created. And you've added all of the content to the topics. However, the content still needs to be formatted with styles.
All of the styles you need already exist in the stylesheet in the template. But we're going to show you
how we created a couple of the styles so you can see how it is done.
This chapter discusses the following:
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Identifying Styles
Before we create new styles, we want to show you how to identify existing styles. If you've ever
looked at a section of content and thought, "I wonder how they got it to look like that," you can easily
find out. It's just a matter of knowing where to look.
1. Open the Front2.htm topic.
2. In the first panel, click somewhere in the blue heading.
3. Look to the far left side of the XML Editor and notice the structure bars. If the tag block bars
are not shown to the left of the content, click

at the bottom of the editor.

The structure bar that is related to the heading has an h1 label.

4. Click somewhere in the line below that contains the two variables.
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5. Now look above the topic. You should see a span bar. If your span bars are not turned on, click
at the bottom of the editor.
Span bars represent elements and formatting that is done inline. Since the current paragraph
has a couple of variables, you will see span bars at the top with MadCap:variable labels.

Similarly, if the paragraph had any bold text, you would see a bar labeled “b.” And if it had a
unique character-level style, you would see a bar simply labeled “span,” but you can hover over
the bar to see the exact style name.
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6. Let's investigate the h1 style. Right-click the h1 structure bar and select Style Class > Edit
Style Class.

The stylesheet opens and automatically selects the h1 style.
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7. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.
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8. In the local toolbar, click
to an alphabetical list.
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9. On the right side of the local toolbar, click the Show drop-down field and select Show: Set Properties. This filters the properties below to only those that have been explicitly set in the
stylesheet for the selected style, as well as any properties explicitly set in an inherited
stylesheet.
As you can see, multiple properties were set on this style, including its size, color, and margins. Any property shown in gray is being inherited from somewhere else (in this case, a factory stylesheet where you installed Flare).
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Creating Styles
Let's re-create a style class that is used in this template. If you look at the original Front topic, you
will see that the first paragraph under the heading is designed to have a larger font size and line
height than a normal paragraph.
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We are going to intentionally create a duplicate of that style class, which we will apply to our Front2
topic.
1. In the upper-left corner of the Stylesheet Editor, click in the drop-down field and select
.
2. On the left side of the Stylesheet Editor, select the p style.
3. In the local toolbar, click Add Selector.

4. In the New Selector dialog, click in the Class Name field and type the following:
large-new
5. Click OK. The new class is added under the p style and is selected.
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6. On the right side of the local toolbar, click in the Show drop-down field and select Show: All
Properties. This displays all of the available properties below.

7. Scroll down the list of properties until you find each of the following properties. Then to the
right of each one, click
and give them the values shown:
n

font-size 13pt

n

line-height 15pt

8. Click

to save your work.

For more information about styles and creating them, see the online Help.
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CHAPTER 6

Applying Styles
Now we are going to apply styles to content in our topics. In addition to previously existing styles, we
will also apply the new style class you created.
This chapter discusses the following:
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Apply Styles to the Front2 Topic
1. Select the Home ribbon, and in the Styles section click Style Window. The window pane opens
on the right side of the interface.

2. Open the Front2.htm topic.
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3. The heading style is already applied, so we can ignore that. Click somewhere in the first paragraph below the heading. The Styles window populates with relevant styles.
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4. In the Styles window pane, select p.large-new, the style class you created.
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In the topic, the paragraph is formatted, increasing in size. This pushes the second-level heading text to the third panel, which is using the second body frame.

5. Select the short copyright paragraphs at the bottom of the first panel.
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6. In the Styles window pane, select p.copyright.
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In the topic, the paragraphs are formatted accordingly, now using a smaller font.

7. Click the first text at the top of the third panel.
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8. In the Styles window, select the h2 style.
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This applies a different look to that text. Also, the h2 style is set to automatically use a frame
break before it, which ensures it begins at the beginning of the body frame, rather than having
other text above it.
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9. The three multi-line paragraphs in the third panel are already using the p style, which is what
we want. But we need to apply styles to the two other second-level headings. First, click in the
next second-level heading, and in the Styles window select h2.no-frame-break.
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The style changes the look of the text, but does not push it to the next panel, because this particular style is not set with a frame break.
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10. Select the next second-level heading, and once again click the h2.no-frame-break style class.
The look of the text changes. Also, the content below it moves automatically to the fourth
panel because there is no room for it on the third panel anymore.
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11. In the fourth panel, click to the right or left of the logo image. Do not select the image itself,
because we want to apply a style to the paragraph holding the image. Then in the Styles window, select the p.logo style class.
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The logo is now centered in the panel.
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12. Click to the right or left of the variable below the logo (do not select the variable itself). Then in
the Styles window, select the p.title style class.
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The look of that content changes.

13. Click
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to save your work.
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Apply Styles to the Back2 Topic
In the other topic, we are going to apply styles that already exist in the stylesheet.
1. Open the Back2.htm topic.
2. Use the same steps above to apply the following styles to the paragraphs in the first panel of
the Back2 topic:
n

Get Started in Apply the p.get-started1 style class.

n

Just a Few Steps Apply the p.get-started2 style class.

n

For more help or troubleshooting… Apply the p.large-light style class.

n

www.yourcompany.com/help Apply the p.large-light-url style class.

n

Created Using MadCap Flare Apply the p.created-using-flare style class.
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The first panel in the Back2 topic should look something like this when you are finished:
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3. In the second panel, click on the Step 1 text, and in the Styles window select the p.step style
class.
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The look of the text changes.

4. Repeat the previous step for the Step 2 and Step 3 text in the third and fourth panels. When
you are finished, the topic should look like this:

5. Click

to save your work.

For more information about applying styles, see the online Help.
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CHAPTER 7

Creating a TOC
At this point you've got two page layouts and two topics with similar names. Now we're going to tie
them together so that the Front2 topic uses the Front2 page layout, and the Back2 topic uses the
Back2 page layout. This is accomplished in a table of contents (TOC) file.
It might seem strange to be creating a TOC for a very short product foldout such as this. But remember, for print-based output (which is what you will be creating here), TOC files function as outlines,
not as traditional TOCs.
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CREATE A TOC
1. Open the Project Organizer on the left side of Flare, and expand the TOCs folder. Notice the
file under it called "TOC (Master)." This is a TOC file—or, more accurately, an "outline TOC"—
which was created for the existing Front and Back topics and page layouts. We're going to create another TOC just like this for the Front2 and Back2 files.

2. Right-click the TOCs folder, and from the context menu select Add Table of Contents. The
Add File dialog opens.
3. The only factory TOC template should already be selected, so in the File Name field, type
TOC2 as the name for the new TOC.
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4. Click Add. The TOC is added to the Project Organizer, and the TOC Editor opens to the right,
displaying the TOC.

5. Open the Content Explorer.
6. Click the Front2 topic, then drag and drop it in the TOC Editor, above the two books. When you
see a blue arrow, you will know that it can be dropped.
7. Click the Back2 topic, then drag and drop it in the TOC Editor, below Front2.
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8. Click on each of the books and press Delete on your keyboard to remove them from the
editor.

What you've added to the TOC Editor are not the topics themselves, but rather a link to each
topic. Now we've got to provide a link to the relevant page layouts.
9. In the TOC Editor, double-click the Front2 entry. The Properties dialog opens.
10. Select the Printed Output tab.
11. In the Break Type field, select Page Layout Break.
12. Click the Page Layout drop-down and select Front2.
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13. Click OK.
14. In the TOC Editor, double-click the Back2 entry. The Properties dialog opens.
15. In the Break Type field, select Page Layout Break.
16. Click the Page Layout drop-down and select Back2.

17. Click OK.
18. Click

to save your work.

For more information about creating outline TOCs for print-based output, see the online Help.
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CHAPTER 8

Developing a Target
The project you created already contains one PDF target.

We are going to create a new PDF target that is not necessarily identical to this existing target, but
the same in the most important areas.
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CREATE A TARGET
1. In the Project Organizer, right-click the Targets folder, and from the context menu select Add
Target. The Add File dialog opens.
2. The only factory target template should already be selected, so in the File Name field at the
bottom of the dialog, type Foldout-New.
3. In the Output Type field, select PDF.

4. Click Add. The new target is created and opens in Flare.
5. In the Target Editor, select the General tab.
6. In the Master TOC field, select TOC2, the TOC you created.

7. Select the Advanced tab.
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8. Remove the check marks from the following fields: Generate TOC proxy, Generate index
proxy, and Generate glossary proxy.

9. Select the PDF Options tab.
10. In the Title field, give your foldout a title.
11. In the Author field, enter your name.
12. If you want, you can select Include Crop and Registration Marks.
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13. Select Convert RGB Colors to CMYK.

CHAPTER 8

95

14. Scroll down on the tab, and in the Navigation field, select Page Only.

15. Click

to save your work.

For more information about developing targets and the various fields you can set in the Target
Editor, see the online Help.
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CHAPTER 9

Building and Viewing Output
Now let's build the PDF output and see how it looks.

BUILD AND VIEW OUTPUT
1. In the local toolbar of the Target Editor, click

.

The Builds window pane opens at the bottom of the Flare interface, and the target begins to
generate.
When the build finishes successfully, the Build Progress cell turns dark green.
2. Double-click the row to open the PDF and review everything you've done.
For more information about PDF targets and building output, see the online Help.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
USER GUIDES

Accessibility Guide

HTML Help Guide

Analysis and Reports Guide

HTML5 Guide

Architecture Guide

Images Guide

Autonumbers Guide

Importing Guide

Condition Tags Guide

Index Guide

Context-sensitive Help Guide

Key Features Guide

Eclipse Help Guide

Language Support Guide

Getting Started Guide

MadCap Central Integration Guide

Global Project Linking Guide

Master Pages Guide
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Micro Content Guide

Source Control Guide: Git

Movies Guide

Source Control Guide: Perforce

Navigation Links Guide

Source Control Guide: Subversion

Plug-In API Guide

Source Control Guide: Team Foundation Server

Print-based Output Guide

Styles Guide

Project Creation Guide

Tables Guide

Pulse Guide

Tables of Contents Guide

QR Codes Guide

Targets Guide

Reports Guide

Templates Guide

Reviews & Contributions Guide

Topics Guide

Search Guide

Touring the Workspace Guide

SharePoint Guide

Transition From FrameMaker Guide

Skins Guide

Variables Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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